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i. Warnings and Cautions 
 
IMPULSE•Link™ Software is Copyrighted © 2003 by Electromotive Systems. All rights reserved. 
 
DISCLAIMER OF WARRANTY 
 
Electromotive Systems, hereafter referred to as Company, assumes no responsibility for improper 
programming of a drive that resulted from use of this software. This software should only be used by 
a trained technician who has read and understands the contents of this manual. Normal use of this 
software may result in the drive parameters becoming modified. Improper programming of a drive can 
lead to unexpected, undesirable, or unsafe operation or performance of the drive. This may result in 
damage to equipment or personal injury. Company shall not be liable for economic loss, property 
damage, or other consequential damages or physical injury sustained by the purchaser 
or by any third party as a result of the use of this software. Company neither assumes nor authorizes 
any other person to assume for Company any other liability in connection with the sale or use of this 
software. 
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Precautions 

1. Read this user manual in its entirety before installing IMPULSE•Link or operating the 
IMPULSE•G+/VG+ Series 2 and/or IMPULSE•G+/VG+ Series 3 and/or IMPULSE•P3 Series 2 Variable 
Frequency Drive(s) (VFD). 

2. DO NOT connect or disconnect wiring, or perform signal checks while the electrical power is turned 
ON. 

Failure to observe these and other precautions indicated in this manual will expose the user to high 
voltages, resulting in serious injury or death. Damage to equipment may also occur. 

 
 

©2003 ELECTROMOTIVE SYSTEMS 
All rights reserved. This notice applies to all copyrighted materials included with this product, including, but not 
limited to, this manual and the software embodied within the product. This manual is intended for the sole use 
of the person to whom it was provided, and any unauthorized distribution of the manual or dispersal of its 
contents is strictly forbidden. This manual may not be reproduced in whole or part by any means whatsoever 
without the expressed written permission of ELECTROMOTIVE SYSTEMS. 
 
NOTICE 
No patent liability is assumed with respect to the use of the information contained herein. Moreover, 
because Electromotive Systems is constantly improving its high quality product, the information contained in 
this manual is subject to change without notice. Every precaution has been taken in the preparation of this 
document. Nevertheless, Electromotive Systems assumes no responsibility for errors or omissions. Neither is 
any liability assumed for damages resulting from the use of the information contained in this publication. 
 
 

Electromotive Systems 
N49 W13650 Campbell Drive 
Menomonee Falls, WI 53051 

 
Phone: 262/783-3500 or 800-288-8178 

Fax: 262/783-3510 or 800-298-3503 
 

www.electromotive.com 
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ii. Introduction 
 
Impulse Link 4.0 is a software program designed to communicate with Drives. Electromotive Drives are Pulse 
Width Modulated Drives for AC 3-Phase induction motors. This type of Drive is also known as an Adjustable 
Frequency Drive, Variable Frequency Drive, AC Drive, AFD, ASD, VFD, VSD, and Inverter. In this manual, it 
will be referred to as the “Drive”. 
 

o A PAR file is a stored set of parameters. Par files may be opened, saved and edited from Impulse Link 4.0. 
o A FIF file is a collection of tables and parameter information essential to the proper retrieval and display of Drive 

parameters. A FIF file exists for each supported Flash ID. 
 
Supported Software 
 
 
This program supports the following Drives and 
Flash IDs: 
 
 

o Multiple revisions of a Flash ID may be 
supported, where available. 

o For a complete list of supported flash software 
versions, open the properties window from the 
Controller menu selection. 

o For the most current FIF files, see the section 
entitled, ”Free Updates, Patches”. 

 

 
Supported Drives Flash IDs 

IMPULSE G+ Series 2 
IMPULSE VG+ Series 2 

14906 
14908 
14909 
14910 
14911 
14912 
14920 
14930 
14940 
14960 
14961 
14962 
14963 
14964 
14965 
14980 

IMPULSE P3 Series 2 5171 
5172 
5182 
5183 

IMPULSE G+ Series 3 
IMPULSE VG+ Series 3 

214 
(unreleased) 

G5 CASE Software 5026 
(also by request) 

V7 CASE Software 8940 
Standard Yaskawa All Supported Drives 

have a generic FIF file 
available for global, 

limited support 
(See Lite-Operation) 
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Chapter 1 -  Overview 
 
IMPULSE•Link 4.0 is a user friendly, Windows® based, interactive PC-to-inverter communication software 
package. It is designed specifically for communicating with Electromotive Systems IMPULSE Series 2, 
IMPULSE Series 3 and IMPULSE P3 Series 2 Drives. 
 
 
 

Supported Communication 
 
IMPULSE•Link 4.0 supports the following types of communication: 
 
 Serial 
 RS232 *1 RS485 *2 
 Availability Protocol Availability Protocol 
IMPULSE G+ Series 2 
IMPULSE VG+ Series 2 

Built In Modbus 
RTU 

Option Card 
(140-10261) 

Modbus 
RTU 

IMPULSE G+ Series 3 
IMPULSE VG+ Series 3 

Built In Modbus 
RTU 

Built In Modbus 
RTU 

P3 Series 2 Built In Modbus 
RTU 

Built In Modbus 
RTU 

 
*1 - USB to Serial converters are available if an RS232 serial port is not found on your PC. 
*2 – A USB to RS485 converter, an RS232 to RS485 converter or an RS485 card is required for your PC. 

 
 

Basic Features 
 
Upload and Download of Drive parameters – A user may retrieve a parameter image from a supported drive 
and save that image to a file for future restoration or comparison. 
 
Load, Save and Print Drive parameters – Impulse Link 4.0 supports basic file operations for parameter files. 
 
Offline Editing – A parameter set may be programmed from Electromotive default settings or from an existing 
Par file and later downloaded to a Drive matching the type, software number and model specified. 
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New Features 
 
Profile-based communication settings – Impulse Link 4.0 allows the user to create communication profiles. 
Once a profile is set up, it may be selected from a drop-down box for easy switching between drives. 
(See Communication Profiles for more information) 
 
Online Editing – As an alternative to using the digital operator to make modifications to Drive parameters, 
online editing may be used to synchronize with the drive and modify parameters in real time, without having to 
navigate through menus.  
(See Online Editing for more information.) 
 
Digital Operator Emulators – An emulated digital operator has been included for each drive type. This gives 
the same functionality as the digital operator, and can be used where a remote serial connection is available. 
(See Digital Operators for more information.) 
 
Automatic / Manual Serial Connection – By default, the communication ports are opened and closed 
automatically, when necessary. By closing the port, it gives another software program on your PC an 
opportunity to take control of that port. Impulse Link 4.0 has an Automatic / Manual optional selection available 
during offline editing. If manual is selected, the user must manually open and close communications. If 
Automatic is selected, Impulse Link will handle the opening and closing of communication ports. 
(See Connection Modes for more information) 
 
Lite Operation Mode – Case and standard software for supported drives are also supported with limited 
operation in Impulse Link 4.0. This allows the user to Upload, Save, Open and Print parameters. All Case 
parameters will be unformatted and without units. A limited number of Case software versions may be fully 
supported. Contact Electromotive Systems for more information. 
 
WindowsTM Explorer Integration – Parameter files (*.Par) may be double-clicked from WindowsTM Explorer to 
be opened in Impulse Link 4.0. 
(See WindowsTM Explorer Integration for more information) 
 
Visual Programming – Some parameters offer a table-based selection, in addition to the normal programming 
style. The Drive manual would normally need to be used to program these parameters otherwise. 
(See Visual Programming for more information) 
 
Parameter File Conversion – In addition to being able to convert your Impulse Link 3.0 par files to Impulse 
Link 4 format, Impulse Link 4.0 also offers a Cross Flash ID conversion feature. 
(See Par Conversion for more information) 
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Chapter 2 -  Software Installation  
 
IMPULSE Link 4.0 Software Kit comes with the following components 

o Installation CD 
o G+/VG+ Series 2 Serial Cable 
o P3 Series 2 / G+/VG+ Series 3 Serial Cable 

 
 

Hardware Requirements 
o IBM-PC compatible computer with a 486/66 MHz processor or higher  
o 32MB or more of RAM       
o Hard disk with at least 25MB of available storage space 
o Super VGA monitor (screen resolution at least 800x600 recommended) 
o Mouse  
o One serial port or USB port.  (Note: USB to Serial converter required if no Serial Port is available) 
 

Operating System Requirements 
One of the following: 
o Microsoft® Windows® 95 
o Microsoft® Windows® NT 4.0 
o Microsoft® Windows® 98 
o Microsoft® Windows® ME 
o Microsoft® Windows® 2000 (build 2031 or later) 
o Microsoft® Windows® XP 
 

Installation from CD 
The IMPULSE•Link 4.0 Drive Interface Software, which also includes the Adobe Acrobat ReaderTM for the Help 
manual, is on one CD. 
Follow the instructions below to install the IMPULSE•Link software program: 
 

1) Run "setup.exe" from the CD if it does not start automatically. 
2) The setup program will ask you for the path you wish to install IMPULSE Link 4.0 and for the optional 

setup of shortcuts and file associations. 
3) During the IMPULSE Link Setup, after copying the system files, a message may appear asking if you 

wish to restart your computer.  Select "OK" and restart the computer.  
 
If problems occur during software installation, refer to the section entitled “Troubleshooting”. 

Free Updates, Patches 
Additional features and bug fixes may be available from time to time. These may be downloaded from the 
Electromotive Systems Diagnostic Tools Website at the following URL: http://dev.electromotive.com. 
 

Software Removal 
To remove the Impulse Link 4.0 Drive Interface Software, open the Control Panel’s Add/Remove Programs 
dialog box, double-click the Impulse Link 4.0 entry and choose Remove All from the Impulse Link 4.0 Setup 
dialog box. 
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Cable Connection Instructions 
 
G+ Series 2, VG+ Series 2 
 
Follow the instructions below to install the download cable: 
Step 1: 
With the power off, remove the keypad from the VFD front cover. 
Step 2: 
Connect the female connector into the Inverter keypad receptacle.  
Step 3: 
Attach the DB-9 connector end of the cable to the serial communication port on the PC. 
 
 
P3 Series 2, G+ Series 3, VG+ Series 3 
 
Follow the instructions below to install the download cable: 
(cable part number 140-10025) 
 
Step 1: 
With the power off, remove the keypad. 
Step 2: 
Connect the RJ45 plug into the inverter keypad receptacle,CN1. 
Step 3: 
Attach the DB-9 connector end of the cable to the serial communication port on the PC. 
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Chapter 3 -  Start Up 
 
 
 
Unlike Impulse Link 3, the 
Controller Properties Window is 
not displayed upon startup. 
Instead, a default offline 
recordset is created, with the 
following attributes: 
 
Drive Type G+ Series 2 
Flash ID 14912.7 
ESI model 2006 
 
 
From this screen the user is 
able to view or modify 
parameters by selecting the 
appropriate parameter from the 
toolbar. The user may also 
access file utilities and assorted 
tools from the toolbar and menu. 
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Chapter 4 -  Programming 
Parameters Overview 
 
 
 
IMPULSE•Link 4.0 maintains a database of 
Drive parameters. This database is set to 
factory default settings when a new drive is 
selected from either 

 
or 

 
 
The database will also be modified if 
parameters are uploaded from the Drive. 
The current set of parameters may be 
viewed by selecting the desired parameter 
group button on the toolbar. 

 
 
By clicking on any column of a particular 
parameter row, additional attributes about 
that parameter may be viewed in the 
properties window, as shown below. 
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Parameter Window Colors 
 
Modified Constant 

 
A parameter with blue text implies that its value is different than its default setting.  

- For G+/VG+ Series 2 and G+/VG+ Series 3 drives, this list should match the modified constants list in 
the drive, with the exception of A1 parameters. The defaults of A1 parameters should reflect 
Electromotive Systems default. 

 
Read-Only 

 
A grayed-out, highlighted parameter implies that it cannot be modified. This can happen for the following 
scenarios. 

- The Access Level of the current parameter set is lower than what is needed for this specific parameter 
(i.e. Changing this parameter from the drive keypad would not be allowed with the current access 
level.) 

- During Online Editing, parameters such as Motion, Control Method and Speed Reference, cannot be 
changed. 

- If the drive is running during Online Editing, the user will be restricted to a minimal set of drive 
parameters, as defined by the drive manual. 

 
Over Maximum / Under Minimum 

 
A parameter with red text implies that its value is either greater than its maximum value or less than its 
minimum. An invalid value in the FIF file could result in this error. 
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Changing Parameters 
 
By clicking on the display column of the parameter you would like to edit, one of the following will appear. 
 
 

List box 

 
 
This will appear for list parameters. Simply 
select the value from the list and: 

- ENTER to accept the change 
- ESC to cancel the change 

 

 
Text box 

 
 
This will appear for decimal, hexadecimal 
and binary formatted parameters. Simply 
type in the value of parameter (in the base 
displayed) and: 

- ENTER to accept the change. 
- ESC to cancel the change. 

 
 
 
 
 
 
 

 
 
NOTES: 
 
1.  

If a change is made, ENTER is not pressed to accept it and the user clicks on another row or column, the 
following dialog will appear. 

  
If ‘Yes’ is selected, the value will revert back to what it was before the change. 
If ‘No’ is selected, the editing of the current cell will continue. 

 
2. 
If a parameter is changed to an invalid value, under the minimum value or over the maximum value, an appropriate 
message will be displayed and the value being edited will revert back to what it was before the change. 
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Visual Programming 
 
A few parameters require the user to choose their setting from a table and program the resultant code into the respective 
parameter. To make this programming a bit easier, Impulse Link 4.0 also contains those tables. The user may click on 
his/her selection, select OK and the resultant code is entered into and accepted for the parameter. 
 
When the user clicks on a parameter, if a […] box appears directly to the right of it (As shown below), a Visual 
Programming function exists for it. By clicking the button a Visual Programming form will open. 
 

 
 
These functions include. 
 
 
 
External Fault Response Selection 
 

Drive Type Applicable 
Parameters 

G+/VG+ 
Series 2 

H1-01 to H1-06 

G+/VG+ 
Series 3 

H1-01 to H1-06 

 
 
Fault Annunciate Selection 
 

Drive Type Applicable 
Parameters 

G+/VG+ 
Series 2 

H2-01 to H2-03 

G+/VG+ 
Series 3 

H2-01 to H2-03 

 
 
 
G5IN4 Setup 
 

Drive Type Applicable  
Parameter 

G+/VG+ 
Series 2 

C9-02 

G+/VG+ 
Series 3 

C9-02 
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Chapter 5 -  Navigation 
 
The user is able to access utilities for uploading/downloading parameters, comparing parameters and saving parameters to 
a file from the program menu. A flow chart of the menu is shown below. 
 

 

 
 
 

 
 

 
 
New… – Brings up the controller properties dialog to create a new factory default 
parameter set for Offline editing, based on the Drive class, software number and 
model number chosen. 
Open File… – Allows the user to select and open a parameter or logger file. 
Close – Closes the current file, after prompting to save a modified file, and loads 
the default parameter set into memory. 
Save - Saves the active file with its current file name and location. 
Save As - Saves the active file with a different file name or location and file type. 
Properties – Brings up the Parfile Properties edit window. 
Print Preview - Shows how a file will look when you print it 
Print - Prints the active parameter set. To select print options, on the File menu, 
click Print. 
Exit - Closes this program after prompting to save a modified file. 
 
(Impulse Link 4.0 also keeps track of the last 4 recently accessed parameter files , 
for convenience.) 
 

 
 
 

 

 
Properties – Brings up the controller properties dialog to view the Drive class, 
software number and model number of the current parameter set. If the settings 
are changed and accepted, a new factory default parameter set with those 
attributes will be created. 
Write Flash - Allows a binary file to be written to Drive flash memory. 
(FACTORY USE ONLY) 
Download Parameters to VFD - Saves all parameter values from memory to the 
Drive. 
Upload Parameters From VFD - Loads all parameter values from the Drive to 
memory. 
Online Edit Mode - With a drive connected to a PC running Impulse Link 4, 
online Edit will allow the user to download parameters in real-time, rather than 
navigating through menus with the Digital Operator. 
Offline Edit Mode - Impulse Link has parameter dependency logic built in, which 
allows a user to create a parameter set offline, as if changing those values within 
the drive and the download that parameter set into the drive. 
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Compare Parameters - Allows for comparison of sets of parameters that 
have the same Drive type and software number. 
Par Conversion –  

• Allows for Impulse Link 3 parameter files to be converted to the 

 
 
 
 

 
 

 
 
Win
 
 
 

from

the
 

 
 
 
 

 
 

 
 
 

Impulse Link 4 format 
• Allows for Impulse Link 4 parameter files to be converted to a newer 

flash ID. 
Digital Operator – Emulated digital operators allow for the navigation of 
Drive menus remotely. 
Monitor – Displays a select number of monitor parameters (U-parameters),  
updated every second. 
 
 

dow - Allows for easy parameter window organization when in multiple window mode. 

 Multiple Window Option – This button selected causes each parameter group selected 
 the toolbar to open in it’s own window. 

 Single Window Option – This button selected causes each parameter group selected from 
 toolbar to open in the same window. 

 
 
 
 
User Manual – Displays the User Manual. (Acrobat Reader must be installed) 
About - Displays the version number of this Electromotive System product; as 
well as copyright and legal notices. 
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Chapter 6 -  Features 
 

Upload 
Loads all parameter values from the Drive to memory. 
 
When choosing Upload Parameters from VFD, Impulse Link will 
automatically detect the drive type, software number and model number and 
load the appropriate FIF file. Once parameter transfer begins, a status bar 
will appear in the upper-left hand corner of Impulse Link.  

 
 
 

 
 
 
 
 

 

Download 
Saves all parameter values from memory to the Drive. 
 
When choosing Download Parameters to VFD, after accepting the download 
warning, Impulse Link will gather information from the connected drive. 
The following information must be equal between the parameter image you 
wish to download in memory and the connected drive. 

o Drive Type 
o Software Number 
o Voltage Class 

Once validated, a status bar will appear in the upper-left hand corner of 
Impulse Link. 

 
 
 

 
 
 
 
 
 
 
 
 
 

 

Save 
Parameter Files 
When a parameter image is in memory, selecting Save As will bring up the following dialog. 
 
From this dialog, the user may choose to either save the 
parameter file or export it to another file type. 
 
Exported file types include: 
 

File Type Description 
Text File 
(*.txt) 

Data may be saved to a text file 
so it can be viewed in programs 
such as Notepad, Wordpad or 
Microsoft® Word. 
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Open 
 
 
By Selecting ‘Open File’ from the File menu, the user 
may choose to open a Parameter File. 
 
By opening a parameter file, the current set of 
parameters or opened file will be lost. Make sure to save 
any changes. 
 
 
Impulse Link toolbars will change, based on the file type 
and the drive type. 
 
G+/VG+ Series 2 toolbar 

 
 
G+/VG+ Series 3 toolbar 

 
 
P3 Series 2 toolbar 

 
 

 
 

 
 
 
 
 
 
 
 
 

 
 

Offline Edit 
 
Offline editing allows for modification of drive parameters without direct interaction with the drive and with an 
easier interface than through the digital operator (keypad). Impulse Link FIF files provide Impulse Link with 
parameter and control information specific to a drive class and software number.  
 
Editing has the following features: 

- List Parameter options are the same as in the digital operator (where applicable) 
- Parameters are visible based on what is accessible via the digital operator. 
- Parameters may be edited based on the current access level. 

The modified constants list in Impulse Link is the same as the VFD. (where applicable) 
 
NOTE: For G+/VG+ Series 2 and Series 3 drives, A1 parameters show ESI default values and may not show 
up in the modified constants list of the drive. 
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Online Edit 
Online editing is an alternative way of changing parameters in the Drive, rather than using the keypad, if a 
serial connection is available. All offline editing features as noted above are also applicable during online 
editing. Once online editing is enabled, as shown below, Impulse Link will identify the connected drive and 
perform an upload of all parameters. Upon editing a parameter and selecting ENTER to accept the value, that 
value will be downloaded to the drive. A watchdog timer is enforced during online edit to monitor the 
connection between the Drive and Impulse Link. If that link is broken, Impulse Link will prompt the user for retry 
or cancel. If cancel is chosen, the online editing session will end. 
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Print Preview 
 
Impulse Link provides a compact printing mode, which displays all drive parameters in only 1-2 pages, as well 
as a more detailed mode, which shows parameter and list descriptions as well as units for each parameter. 
 
 
Compact Parameter Print Preview 

 
 
 
 
 
 
 
 Detailed Parameter Print Preview  
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Print 
Parameter Files 
When a parameter image is in memory, selecting Print will bring up the following dialog. 
 
 
 

 
 
 
NOTE: Only parameters that are viewable in the 
Parameters Window will be printed. 
 
 

 
Printer Setup – Allows the user to select from any printer 
installed on his/her system. The user’s default printer is 
initially selected. 
Preview – Gives a preview of the printer output with the 
selected options. 
Print What – Allows the user to choose the printing style.  

o Compact mode (1-2 pages) provides parameter 
name and value, as well as ‘modified’ information.  

o Detailed mode provides parameter descriptions, 
units, and list value descriptions, as well as 
parameter name, value and ‘modified’ information. 

Print to File – With this checked, the printout will be saved 
to an ascii text file (.txt), instead of printing to a printer.  
OK Button – Prints the active parameter set to the selected 
printer in the chosen format. Changes to Customer Name, 
Application and Job Number are saved. Change to the 
‘Print What’ option is not saved.  
(This option can be saved from the ‘Preferences’ option 
under the ‘Tools’ Menu.) 
Cancel – Closes this dialog box without printing. Changes 
to Customer Name, Application and Job Number are not 
saved. 
 
Text placed in the Customer Name, Application and Job 
Number fields appear on the printout. 
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Controller Properties 
 
 

 
 
 
The Drive Properties Window has two functions. 

o It tells the attributes of the current 
parameter set. 

o It allows a factory default parameter set to 
be created with the attributes chosen. 

 
NOTE: If in Online editing mode and a new 
parameter set is created from this form, Impulse 
Link 4.0 will end Online editing and switch to Offline 
Mode. 
 

 
Drive Model – Displays a list of supported Impulse Link 4.0 
Drive types or groups according to the FIF files installed. 
Software Version – Displays a list of supported Impulse 
Link 4.0 Software Numbers for the selected Drive Model, 
according to the FIF files installed. 
Software Revision – Several revisions may exist for a 
given software number. A revision would include any minor 
change to that software, including a change in parameter 
defaults or range, or an addition of a new parameter. If the 
FIF file of the selected / identified flash ID does not support 
multiple revisions, this list box will not be displayed. 
Impulse Model # - Displays a list of supported Model 
numbers for the Drive Model and Software Version 
selected. 
OK Button – This button has two functions. 

o If the New option was selected from the File Menu 
to display this form, the OK button will cause a new 
parameter set with factory defaults according to the 
Drive Model, Software version and Impulse Model 
# specified, even if nothing has been changed. 

o If the Properties option was selected from the 
Controller Menu, the OK button will only create a 
new parameter set if any information in the list 
boxes have changed and OK is selected from the 
“Confirm” dialog. 

 
Cancel Button – Closes this form without making any 
changes. 
Auto-Scan – Autoscan will use the current communication 
settings and determine which type of drive, software 
number and model number is connected, and fill in that 
information. If Impulse Link 4.0 does not support the Drive 
scanned, a message box will inform the user and no 
changes will be made. 
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Digital Operators 
 
 

 

 
 

 
 
Emulated Digital Operators allow for navigation of Drive menus while in 
Impulse Link. 
 
 
Digital Operator Emulator NOTES:  
 

o To Activate, Select the “Connect” check box. 
o The emulators use the communication settings as defined in Impulse 

Link preferences. 
o The emulators will automatically close if any communication function, 

such as Upload and Download is selected, or a new offline parameter 
set is created from the Controller Properties window. 

o The RUN command has been disabled for  safety reasons. 
o If the drive is put into “Program Mode” and not back into “Run Mode”, 

just like the hardware keypad, the operator will be unable to run the 
drive. 

 
 
 
 
 
 
 
 
 
 
 
 
The G+/VG+ Series 3 Emulated Digital operator will be supported. 
(See coming features for more information) 
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Compare Par Files 
 
 
 

 
 
 
The Compare Parameters function allows the user 
to quickly and easily compare the values of two 
different parameter files or a parameter file and a 
Drive parameter set. 
 

 
 

 Prints the comparison results shown to the 
Default printer. (Ctrl+P) 

 Returns only parameters that are Not Equal to 
the results textbox. (Ctrl+Shift+E) 

Returns only parameters that are Equal to the 
results textbox. (Ctrl+E) 

Returns ALL parameters to the results textbox. 
(Ctrl+A) 
 

 
 
File to File – Impulse Link will prompt the user to 
select two filenames. Once they are selected, the 
above form will appear with the Not Equal results 
placed in the textbox. 
VFD to File – Impulse Link will upload a parameter 
set from the connected VFD and then prompt the 
user for a par filename. Once it is selected, the 
above form will appear with the Not Equal results 
placed in the textbox. 
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Par Conversion 
Impulse Link 3 to Impulse Link 4 Conversion 
 
The Impulse Link 4 parameter file format has been modified from previous versions to better capture a correct Drive 
image. Previous versions of parameter files can be converted to Impulse Link 4 format, from either the Par Conversion 
option in the Tools menu or just by opening them through the ‘Open File’ option in the File menu. 
 
By selecting the ParConversion option from the Tools menu, the following dialog will be displayed. 
 

 
 

 
 

 

 
Source Par Type – Shows the format of the parameter file to be 
converted. It is set when a filename is selected. 
Source Filename – Specifies the Parameter file to be converted. A 
description of the parameter file type 

 button – Opens a file open dialog for selection of the source 
parameter file. 
Convert - Converts the parameter file specified in 'Source Filename' 
to the format specified in 'Dest Par Type'. The converted file is saved 
to the filename and path specified in 'Destination Filename'. 
 
 
 
 
 
Dest Filename – Specifies the Parameter file to be converted. A 
description of the parameter file type 
Destination Par Type – Shows the destination format of the 
parameter file to be converted.  

 button – Opens a file save dialog for selection of the destination 
parameter file. 
Convert - Converts the parameter file specified in 'Source Filename' 
to the format specified in 'Dest Par Type'. The converted file is saved 
to the filename and path specified in 'Destination Filename'. 
 
 
 
 
 
 
The output tab gives information about the results of the conversion. 
This tab is automatically switched to when the convert function is run. 
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Cross-Flash ID Parameter Conversion 
 
This feature allows a user to convert a parameter file across Drive flash versions. For instance, if a Drive was being 
replaced, it would come with the latest and greatest software, unless specifically requested. To ease the tedium of 
programming the new drive, this function allows the user to convert the original par file with version 14909, for example, to 
version 14912. Any new parameters would be set to the 14912 default settings and a list of new and removed parameters 
would be displayed upon conversion. 
 
WARNING: Do not blindly trust the conversion. Make sure you review all settings before downloading them into 
the drive. 
 
Restrictions: 
· A Par file may only be converted within its software family. (i.e. 14906, 14908, 14909, 14911, 14912) 
· A Par file may only be converted forward. (i.e. 14908 can be converted to 14909, 14911, etc.  14909 cannot be  

converted to 14906 or 14908) 
· A converted par file cannot be converted. 
 
 
Software Families 
 

Drive Type Flash Ids 
IMPULSE  
G+/VG+ Series 2 

14906, 14908, 14909, 
14911, 14912 

Hoist Sync Software 14920 
Bucket Software 14910, 14940 
Acetronics  
HG+/TG+ / HVG+ 

14960 - 14965 

P3 Series 2 
(5.5 HP and below) 

5171,5172 

P3 Series 2 
(7.5 and 10 HP) 

5182,5183 
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How to use: 
 
1. Select “Tools->Par Conversion” from the Menubar and the following dialog will appear. 
 

 
 
2. Click on the […] box to the right of “Source Filename” and select a par file. Once selected, IL4 will detect 
which type of par file it is and display it in the Source Par Type label, as shown below. 
 

  
 
3. The “Destination” tab and conversion type will also be different based on the par type. For IL3 files, files may 
be converted from the IL3 to IL4 format. For IL4 par files, files may be converted across the allowed flash IDs. 
 
4.  Select the Destination Filename by clicking the […] box to the right of the “Dest Filename” and select the 
destination software version (and revision, where applicable). 

 
Click on Convert to begin converting. Focus will be set to the “Output” tab, which will display any errors or 
items that occurred during the conversion. 

 
 
 
WARNING: Review ALL settings before downloading. 
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Communication Profiles 
 
Up to ten profiles may be created, each with a user-specified name, allowing networked drives to be quickly 
selected without constantly changing settings. 
 
 
 
To Add a New Profile, click on the ‘Add’ button. The following Dialog will 
prompt you for a Profile Name. This may be anything up to 25 characters 
long. 
 
Whatever settings were displayed when ‘Add’ was clicked, are originally 
set in your new profile. 
 
Communication Selection: 
The following Communication Selections are available: 

- Serial:  
• RS232  
• RS485 

 
 
Protocol Selection: 
The following protocols are supported: 

- Modbus RTU: 
• Choose this protocol for use with a serial 

communication selection or with a TCP/IP to RS232 
or RS485 converter. 

 
Baud Rate Selection: 
By default, the drive baudrate is 9600 bauds/sec. This setting allows the 
user to select the PC baudrate to connect at in the case that the target 
drive is not at 9600 baud. 
 
Flash Baud Rate Selection: 
(Factory Use Only) 
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Connection Modes 
 
A common problem that occurs today is gaining control 
of your PC’s serial port. It is often found that PDA 
software and various other software packages run 
continuously in the background and hold the serial port 
for their own use. By default, Impulse Link gains control 
of your serial port only when beginning a 
communication operation. When that operation has 
been completed or canceled, control over that port is 
released. By selecting Manual offline connection mode, 
the user commands the destination communication port 
to open or close, if available. 
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WindowsTM Explorer Integration 
 
 
Double-Click and Right-Click functionality has been 
integrated into Windows Explorer for use with 
Impulse Link par files.  
 

• By Double-Clicking on a par file, it will be 
opened in Impulse Link 4.  

• By Right-Clicking on a par file and choosing 
“Properties”, a brief summary of that file 
contents can be seen. 
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Chapter 7 -  Troubleshooting 
 

Installation / Startup 
 
Fault Message Fault Description Corrective Action 
Impulse Link 4 
could not 
initialize.  
View Error.log 
for Details 

This is typically due to a database interface error. 
Either the database cannot be found or the 
correct DLLs do not exist in the system. 

1. Ensure that the file “G5_14912_v2-00.fif” 
exists in the fifs directory. (C:\Program 
Files\Impulse Link 4.0\fifs\ 

2. Install “mdac_typ_2.53.exe”, found on all 
versions of the Impulse Link 4 CD to date. 

3. Install “mdac_typ_2.6.exe”, found on all 
versions of the Impulse Link 4 CD to date. 
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Communication 
 
Fault Message Fault Description Corrective Action 
Error Communicating with 
drive.  
Verify that the proper… 

This error occurs when a message is sent to the 
drive and there is no response for the length of 
the user-specified time-out period. 

1. Ensure that the cable is 
connected. 

2. Cycle power on the drive to 
reset the drive serial port with 
the default baudrate. 

3. Ensure that the correct 
baudrate is selected in your 
communication preferences. 

4. Lengthen the Timeout setting 
in your comunication profile. 

5. Swap cables, if available. 
The Specified 
Communication Port could 
not be Opened.  
Verify that… 

This error occurs if Impulse Link could not 
successfully open the specified communication 
port. It either doesn’t exist or is in use. 

1. Verify that PDA or other serial 
communication software is not 
running. 

2. Verify that the specified 
communication port exists.. 

 
 

Other 
 
Fault Message Fault Description Corrective Action 
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Appendix A -  Quick Reference 
 

Shortcuts 
 

Function Shortcut Parent Menu 
New Control + N File 
Save Control + S File 
Open Control + O File 
Print Control + P File 
Download Control + Shift + D Controller 
Upload Control + U 

Control + Shift + U 
Controller 

Enable Online Edit Control + Shift + O Controller 
Enable Offline Edit Control + Shift + F Controller 
 
 

How to: 
 

Action Steps 
Read parameters from a Drive 1. Select 'Communications' from the Settings menu 

2. Ensure that the settings in the selected profile are accurate to your 
connection. Select 'OK' to close the Settings dialog. 
3. Choose 'Upload Parameters from VFD'. 
4. Once the status bar reaches 100%, it will disappear and 'Upload 
Successful' will appear in the status window. The Drive parameters are now 
in memory and may be saved, printed or edited. 

Write Parameters from a saved file to a 
Drive 

1. Open a parameter file by selecting 'Open File' from the File menu. 
2. Once selected, make sure to review all parameter settings before 
continuing. 
3. Select 'Communications' from the Settings menu 
4. Ensure that the settings in the selected profile are accurate to your 
connection. Select 'OK' to close the Settings dialog. 
5. Choose Download Parameters to VFD'. 
6. Accept the Download Confirmation dialog by choosing 'OK'. 
7. Once the status bar reaches 100%, it will disappear and 'Download 
Successful' will appear in the status window. 
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Appendix B -  Coming Features 
 

G+/VG+ Series 3 Emulated Digital Operator 
An Emulated Digital Operator will be available for the G+/VG+ Series 3 drives in the near future. 
Be sure to check http://dev.electromotive.com for updates. 
 

 B-1 

http://dev.electromotive.com/
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